# Contents

## Preface

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About this Guide</td>
<td>4</td>
</tr>
<tr>
<td>Disk Capacity and Transfer Rate Measurement Conventions</td>
<td>4</td>
</tr>
</tbody>
</table>

## Overview

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tableau TD3</td>
<td>6</td>
</tr>
<tr>
<td>TD3 Kit Contents</td>
<td>7</td>
</tr>
<tr>
<td>Navigating the TD3</td>
<td>10</td>
</tr>
<tr>
<td>Reading the LEDs</td>
<td>11</td>
</tr>
<tr>
<td>Interpreting Audio Feedback</td>
<td>12</td>
</tr>
<tr>
<td>USB Keyboard Support</td>
<td>12</td>
</tr>
</tbody>
</table>

## Setting up the TD3

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Startup Sequence</td>
<td>14</td>
</tr>
<tr>
<td>Configuring the TD3</td>
<td>14</td>
</tr>
<tr>
<td>Settings</td>
<td>14</td>
</tr>
<tr>
<td>Updating TD3 Firmware</td>
<td>24</td>
</tr>
<tr>
<td>Connecting Hard Disks</td>
<td>24</td>
</tr>
<tr>
<td>Connecting Notebook Hard Disks</td>
<td>25</td>
</tr>
<tr>
<td>Drive Detection</td>
<td>25</td>
</tr>
<tr>
<td>Twinning Mode</td>
<td>27</td>
</tr>
</tbody>
</table>

## Using the TD3

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>32</td>
</tr>
<tr>
<td>Navigating TD3 Modules and Options</td>
<td>32</td>
</tr>
<tr>
<td>Duplicate</td>
<td>34</td>
</tr>
<tr>
<td>Disk-to-File/Imaging</td>
<td>34</td>
</tr>
<tr>
<td>Disk-To-Disk/Cloning</td>
<td>35</td>
</tr>
<tr>
<td>Disk-To-File Duplication/Imaging</td>
<td>37</td>
</tr>
<tr>
<td>Disk-To-Disk/Cloning</td>
<td>40</td>
</tr>
<tr>
<td>Duplication Over a Network</td>
<td>42</td>
</tr>
<tr>
<td>Hashing</td>
<td>46</td>
</tr>
<tr>
<td>Preconditions Checking</td>
<td>47</td>
</tr>
<tr>
<td>Verifying</td>
<td>49</td>
</tr>
<tr>
<td>Disabling HPA and DCO</td>
<td>50</td>
</tr>
<tr>
<td>Removing HPA and DCO</td>
<td>50</td>
</tr>
<tr>
<td>Blank Checking</td>
<td>51</td>
</tr>
<tr>
<td>Formatting Destination Drives</td>
<td>51</td>
</tr>
<tr>
<td>Accessing ext2, ext3, and ext4 Destination Partitions in Windows</td>
<td>52</td>
</tr>
<tr>
<td>Prerequisites, Assumptions, and Limitations</td>
<td>53</td>
</tr>
<tr>
<td>Procedure for Mounting ext Volumes</td>
<td>53</td>
</tr>
<tr>
<td>Wiping Destination Media</td>
<td>56</td>
</tr>
<tr>
<td>Secure Erasing</td>
<td>58</td>
</tr>
</tbody>
</table>
## Logs Module

- Viewing Logs: 58
- Sample Log: 59
- Saving Logs: 60
- Printing Logs: 61
- Erasing Logs: 61

## Expansion Modules

- Overview: 64
- TDPX5 Expansion Module for IDE Drives: 64
  - Using the TDPX5: 64
- TDPX6 Expansion Module for SAS Drives: 66
  - Using the TDPX6: 66
- TDPX8-RW USB 3.0 Expansion Module for USB Destination Drives: 68
  - Using the TDPX8-RW: 68
- TDPXE Gigabit Ethernet Expansion Module: 69
  - Using the TDPXE: 70

## Troubleshooting and Support

- Troubleshooting Common Problems: 72
  - Power Supply Issues: 72
  - Problems with Disk Detection: 72
  - Replacing the Backup Battery for the Real-Time Clock: 73
- Support: 75
  - Technical Support: 75
  - Online Support: 76
- Professional Services: 80
- Training: 81

## Index

- Index: 83
Preface
About this Guide

This guide presents a wide range of technical information and procedures for using the TD3. It is divided into the following chapters:

- **Overview**: Provides general information about the TD3 as well as unpacking, starting up, and navigating the TD3’s menus and LEDs.
- **Setting up the TD3**: Provides system overview information about the TD3 as well as procedures for configuring and connecting the TD3.
- **Using the TD3**: Provides detailed information and procedures for TD3 operation.
- **Expansion Modules**: Describes the expansion modules that extend the product imaging and network capabilities of the TD3.
- **Troubleshooting and Support**: Provides a brief list of potential problems and solutions. For more complete and current troubleshooting information as well as answers to frequently asked questions (FAQ), visit the Tableau web site at [www.tableau.com](http://www.tableau.com).

Disk Capacity and Transfer Rate Measurement Conventions

The computer industry generally adheres to two different conventions for the definitions of the terms megabyte (MB) and gigabyte (GB). For computer RAM, 1 MB is defined as $2^{20} = 1,048,576$ bytes and 1 GB is defined as $2^{30} = 1,073,741,824$ bytes. For disk storage, 1 MB is defined as $10^6 = 1,000,000$ bytes and 1 GB is defined as $10^9 = 1,000,000,000$ bytes. These two conventions are known as powers of two and powers of ten respectively. Microsoft deviates from the hard disk capacity measurement convention and uses the powers of two convention for its operating systems.

Tableau reports disk capacities and transfer rates according to the industry standard powers of ten convention. In TD3 screens, reports, and documentation, a 4 GB hard disk stores up to 4,000,000,000 bytes; a hard disk with a 150 MB/sec transfer rate transfers 150,000,000 bytes per second.
Overview

- Tableau TD3
- TD3 Kit Contents
- Navigating the TD3
- Reading the LEDs
- Interpreting Audio Feedback
- USB Keyboard Support
Tableau TD3

The Tableau TD3 is a powerful, intuitive, modular forensic imaging system using a touch-screen graphical user interface. The TD3 provides many of the functions traditionally found in general purpose, IT-oriented hard disk duplicators while also providing features and functions that serve specialized needs of the digital computer forensic industry, including:

- Sustained data transfer rates of up to 7.2 GB/minute, while performing calculations of MD5 and SHA-1 hash values, also known as fingerprints.
- Native support for SATA, USB 3.0 and FireWire hard disks from the source interface.
- Additional support for SAS and IDE hard disks using expansion modules.
- Native support for connecting to network storage CIFS and ISCI shares.
- Network-based write blocking of attached storage media.
- Detailed log generation for case documentation.
- Automatic blank checking of source and destination drives.
- HPA and DCO support for the detection and handling of hidden/protected data areas on source drives.

The TD3 was designed as a flexible modular imaging system. As shown above, the TD3 can stand alone and interface with SATA, USB 3.0, and FireWire source disks, a SATA destination disk, and network shares.
You can also easily combine the TD3 with an Expansion Module and a TDS1 or TDS2 SATA Storage Module for additional capability. The TD3 is shown below connected directly to one of the Expansion Modules and the TDS2 SATA Storage Module.

## TD3 Kit Contents

The TD3 ships in a boxed kit that includes the items shown in the following table.
<table>
<thead>
<tr>
<th>Item</th>
<th>Model #</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TD3</td>
<td></td>
<td>TD3 Forensic Duplicator.</td>
</tr>
<tr>
<td>TP4-NC</td>
<td></td>
<td>High-output power supply. The TP4 provides enough power to supply the TD3 and most common combinations of source and destination hard disks. The TP4 uses a universal 3-pin AC line cord and is compatible with 110-240VAC line voltages worldwide.</td>
</tr>
<tr>
<td>TDS2</td>
<td></td>
<td>Tool-less removable SATA storage module for destination SATA hard disk. Supports adding twinning functionality by stacking two TDS2 units.</td>
</tr>
<tr>
<td>TDPX5</td>
<td></td>
<td>Forensic IDE expansion module to adapt to IDE source hard disks.</td>
</tr>
<tr>
<td>TDPX8-RW</td>
<td></td>
<td>USB 3.0 Read/Write Expansion module, allowing USB 3.0 drives to be used as a destination.</td>
</tr>
<tr>
<td>TP4-LC-US</td>
<td></td>
<td>North America shipments include the TP4-LC-US AC line cord for use with the TP4-NC power supply. When shipped to other geographic markets, the local reseller typically adds an AC line cord appropriate for the local market.</td>
</tr>
<tr>
<td>Item</td>
<td>Model #</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>TC2-8-R2</td>
<td></td>
<td>Hard disk power cable to connect IDE and some legacy-style SATA hard disks to the TD3 (3M to Molex).</td>
</tr>
<tr>
<td>TC3-8</td>
<td></td>
<td>SATA signal cable to connect SATA hard disks to the TD3.</td>
</tr>
<tr>
<td>TC4-8-R2</td>
<td></td>
<td>SATA/SAS power/signal cable to SATA/SAS signal and 3M power (2 pieces). This unified cable connects to newer SATA hard disks with a unified connector.</td>
</tr>
<tr>
<td>TC5-8-R2</td>
<td></td>
<td>Hard disk power cable to connect 15-pin SATA power connectors to the TD3 (SATA to 3M).</td>
</tr>
<tr>
<td>TC6-8</td>
<td></td>
<td>IDE signal cable to connect IDE hard disks to the TD3. Do not use the TC6-8 IDE cable to connect notebook drive adapters to the TD3. Use the shorter TC6-2 IDE cable shown with the TKA5-AD adapter pack below.</td>
</tr>
<tr>
<td>TC7-6-6</td>
<td></td>
<td>6-pin FireWire cable to connect FireWire storage media devices as source disk.</td>
</tr>
<tr>
<td>TCA7-6-9</td>
<td></td>
<td>FireWire cable adapter to adapt from 1394A 6-pin to 1394B 9-pin. Used to connect FireWire devices with 1394A 6-pin connectors.</td>
</tr>
<tr>
<td>TC-USB3-18</td>
<td></td>
<td>USB 3.0 cable (A to B) to connect USB 3.0 storage media as source disk.</td>
</tr>
<tr>
<td>TC3-22-18</td>
<td></td>
<td>Unified SATA cable (22-pin male to 22-pin female) to connect a destination SATA hard disk. Used when imaging to a bare SATA hard disk instead of to TDS1/TDS2.</td>
</tr>
<tr>
<td>Item</td>
<td>Model #</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>TDA</td>
<td>Multipack</td>
<td>Adapter pack for notebook hard disks. Includes TC6-2, TDA3-1, TDA3-2, TDA3-LIF with 2 LIF cables, TDA5-18, TDA5-25, and TDA5-ZIF with TC20-BNDL cables in a black TB4 bag</td>
</tr>
<tr>
<td>TPKG-VCT-5</td>
<td></td>
<td>Five pack of Velcro cable ties.</td>
</tr>
<tr>
<td>TQS-TD3</td>
<td></td>
<td>Quick Start card for TD3 kit.</td>
</tr>
</tbody>
</table>

Do not discard the foam packaging, as it is designed to fit several industry-standard hard-sided carrying cases. If you received the TD3 kit in the cardboard box shipped by Tableau, you can buy a hard-sided case and reuse the foam insert directly into that case.

**Navigating the TD3**

Use the TD3’s touchscreen display to navigate from module to module and choose or modify options. Use the touchscreen keyboard or a USB keyboard (see **USB Keyboard Support** on page 12) to enter alphanumeric text when prompted.
The Main Menu screen of the TD3 displays a sliding icon list for initiating the various functions:

- Duplicate
- Hash
- Verify
- HPA/DCO Disable
- Blank Check
- Format
- Wipe
- Logs
- Settings

From the Main Menu screen, tap an icon to access a function screen. A function screen provides a set of graphic icons, from which you can select options and suboptions, add and change information, or initiate a task. A button on each screen takes you back to the previous screen or to the Main Menu screen. Across the top of the display, the TD3 continually shows the chosen profile and its locked/unlocked status, the screen title, and the time.

The TD3 ships with a Quick Start card that illustrates the layout of the display, connectors, and power switch on the TD3. Keep the Quick Start card with the TD3 as you familiarize yourself with its operation.

**Reading the LEDs**

**On/Off indicator LED:** The top of the TD3 has one light emitting diode (LED) indicating that the unit is turned on.

**DC In LED:** The back of the TD3, near the power connector, has one LED indicating that the power supply is plugged in.

**Network Interface LED:** The right side of the TD3, on the RJ-45 Ethernet connector, has two LEDs. The following table provides details for interpreting the status of these network interface card LEDs.

<table>
<thead>
<tr>
<th>Status</th>
<th>Green LED</th>
<th>Yellow LED</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000 Mbps Link – No Activity</td>
<td>On</td>
<td>Off</td>
</tr>
<tr>
<td>1000 Mbps Link – Activity</td>
<td>On</td>
<td>Blink</td>
</tr>
<tr>
<td>100 Mbps Link – No Activity</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>100 Mbps Link – Activity</td>
<td>Blink</td>
<td>Blink</td>
</tr>
<tr>
<td>10 Mbps Link – No Activity</td>
<td>Off</td>
<td>On</td>
</tr>
<tr>
<td>10 Mbps Link – Activity</td>
<td>Blink</td>
<td>On</td>
</tr>
<tr>
<td>No Link</td>
<td>On</td>
<td>On</td>
</tr>
</tbody>
</table>
Interpreting Audio Feedback

The TD3 plays one of two sounds to alert you of the end of a disk operation. There is a chime to indicate successful completion of the operation, and a buzzer to indicate a failure to complete the operation. You can turn sounds off from the System Settings submenu in the Settings menu.

USB Keyboard Support

You can connect a standard USB keyboard to the USB port on the right side of the TD3. Using an external keyboard can be more convenient than entering data using the touchscreen keyboard on the TD3.
Setting up the TD3

- Startup Sequence
- Configuring the TD3
- Connecting Hard Disks
- Drive Detection
- Twinning Mode
Startup Sequence

The TD3 is optimized for the needs of forensic practitioners and computer forensic processes. When you turn on the TD3 for the first time, an initialization screen displays for about 20 seconds, followed by a prompt to create an administrator password. The TD3 then loads the initial profile, detects any connected devices, and displays the Main Menu. The TD3 displays icons indicating connected devices, special settings, and warning messages about any detected faults.

Configuring the TD3

The TD3 has a variety of options and settings you can configure and customize to your individual needs. Scroll to the right to see the Settings icon on the Main Menu Screen. Tap the Settings icon to display the Settings menu.

Settings

The Settings module provides selections for configuring TD3 options, defaults, profile management, and the current date/time. It also provides options for viewing TD3 information and current status.

System Settings
Setting up the TD3

System Settings provides options for the following.

- **Start Screen**: Select default Start Screen/one-click configuration by choosing one of the following options:
  - Main Menu
  - Duplicate
  - Hash
  - Verify
  - Wipe

- **Network**: Changes the settings for the Ethernet port (see *Network Settings* on page 15).
- **Sounds**: Enables audio alerts for TD3 operations.
- **24-Hour Time**: Enables 24-hour time display for the TD3 clock.
- **Date & Time**: Sets the date and time for the TD3 clock.
- **Brightness**: Sets the brightness of the TD3 touchscreen display.
- **Factory Reset**: Resets the TD3 to factory default settings.

**Network Settings**

Network Settings provides options for the following.

<table>
<thead>
<tr>
<th>Interface</th>
<th>TD3 Ethernet</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use DHCP</td>
<td>ON</td>
</tr>
<tr>
<td>MTU</td>
<td>1500</td>
</tr>
</tbody>
</table>

- **Interface**: Switches which Ethernet interface you are currently modifying the settings for.
- **Use DHCP**: Enables automatic network configuration using the DHCP protocol if turned on, otherwise, you are required to enter IP address, Netmask, and Gateway values.
- **MTU**: Displays the Maximum Transmission Unit, the largest packet size the connected network can support. Contact your network administrator before switching this value from the default value of 1500. Larger values of MTU may improve performance if switches and servers on the network support it.
- **IP Address, Netmask and Gateway**: Sets the respective values for IP address, netmask and gateway. Consult your network administrator for these settings. Incorrect or inappropriate values can cause issues not only for the TD3, but also for other users on the network.
- **Apply Settings**: Applies network settings to the configuration of the Ethernet port.
iSCSI

iSCSI Settings provide selections for the following options.

- **iSCSI**: Enables or disables iSCSI capabilities. When set to OFF, all TD3 iSCSI functionality is disabled.
- **Export Source Drive**: Enables or disables iSCSI sharing of SATA, IDE, USB, and FireWire source drives connected to the TD3. When these options are set to ON, the source/destination disk physically attached to the TD3 is exported as a read-only iSCSI target. This allows a remote computer to connect to these disks over iSCSI.

  **Note**: For additional information on setting up an iSCSI initiator, see the Microsoft TechNet article at: http://technet.microsoft.com/en-us/library/ee338476(v=ws.10).aspx.

- **Export Destination Drive**: Enables or disables iSCSI sharing of SATA destination drives connected to the TD3 as read-only iSCSI targets.
- **Discover New Targets**: Displays the iSCSI Discover screen. This initiates the process of discovering targets on a remote machine and logging into them.

**Bookmarked Targets, Logged in Source Targets** and **Logged in Destination Targets**: Displays the iSCSI Target List screen and a list of targets.

  - **Bookmarked Targets** displays all the targets currently bookmarked, whether they are logged in or not.
  - **Logged in Source Targets** and **Logged in Destination Targets**: Display all the targets you are logged in to as a source or destination, respectively.

iSCSI Discover
Setting up the TD3

- **Address (IP or Hostname):** The IP address or Hostname of the server where the iSCSI targets are located. This field is required.

- **Discovery Username** and **Discovery Password:** Some iSCSI servers require a username and password to perform the discovery process on them, and some do not. These may or may not be the same username and password used to log into the targets. These fields are optional.

- **Discover:** Displays the Discovered iSCSI targets screen and a list of targets discovered on the server.

*Discovered iSCSI Targets*

- Any target listed: Pressing any of the targets listed on this screen displays the iSCSI Login screen where you can log into that share. Each target listed has two status icons in its button, shown below.

  - This icon indicates whether the target is logged in (first image) or logged out (second image).

  - This icon indicates whether the target is bookmarked (first image) or not bookmarked (second image).

*iSCSI Login*

- **Source Drive** and **Destination Drive:** Determines whether the iSCSI target is logged in to as a source or destination drive. One must be selected. The default is **Source Drive**.
- **Login Username** and **Login Password**: If a username and password are required to login to the target, enter it here. These fields can be optional.
- **Bookmark Target**: Set to ON to bookmark a target for future use.
- **Connect at Startup**: This option is valid only if the target has been bookmarked. If this is set to ON, as soon as you log in to the TD3 with your profile, the TD3 attempts to connect to this share in the background.
- **Nickname**: This option is valid only if the target has been bookmarked. You can enter an alphanumeric string here to give the target a nickname, displayed with the full target name.
- **Target Enable**: After verifying that all of the above options are correct, switch this to ON to begin logging in to the target. When complete, it displays the Source iSCSI Targets screen.

**Source**

**iSCSI Target List**

Any target listed: Depending on which button you selected on the iSCSI Settings screen, this screen displays all your bookmarked targets, all the targets logged in to as a source, or all the targets logged in to as a destination. Pressing any of the targets in this screen displays the iSCSI Target Options screen, where you can log in to or out of the target and edit its settings. Each target button has two status icons, as shown below:

- This icon indicates whether the target is logged in (first image) or logged out (second image).
- This icon indicates whether the target is bookmarked (first image) or not (second image).
**iSCSI Target Settings**

- **Source Drive** and **Destination Drive**: Determine whether the iSCSI target is logged in to as a source or destination drive. One must be selected. The default is Source Drive.
- **Discovery Username** and **Discovery Password**: Some iSCSI servers require a username and password for the discovery process and some do not. These may or may not be the same username and password used to log in to the targets. These fields can be optional.
- **Login Username** and **Login Password**: If a username and password are required to log in to the target, enter it here. These fields can be optional.
- **Connect at Startup**: If set to ON, as soon as you log in to the TD3 with your profile, the TD3 attempts to connect to this share in the background.
- **Nickname**: You can enter a string here to give the target a nickname, displayed with the full target name.

**Duplication Settings**

Duplication Settings provides options for the following.

- **Examiner**: The name of the case examiner.
- **Case ID**: The case ID number.
- **Case Notes**: Miscellaneous information about the case or duplication process for future reference.
- **Duplication Type**: Either Disk-to-File (imaging) or Disk-to-Disk (cloning) duplication. The default is Disk-to-File.
- **Destination Dir**: The path on the destination disk for a disk-to-file duplication.
- **Image Dir Naming**: The directory naming convention for a collection of disk-to-file duplications.
  - **Date + Time**: A time stamp identifies the directory. This is the default setting.
  - **Serial Number**: The serial number of the source disk identifies the directory.
  - **Serial + Model Number**: The model and serial number of the source disk identifies the directory.

- **Image File Naming**: The file naming convention for a disk-to-file duplication.
  - **Date + Time**: A time stamp identifies the duplication. This is the default setting.
  - **Serial Number**: The serial number of the source disk identifies the duplication.
  - **Serial + Model Number**: The model and serial number of the source disk identifies the duplication.
  - **User Defined**: A predefined alphanumeric string identifies the duplication.

- **File Format**: Choose the file format for a disk-to-file duplication.
  - **DD - raw binary data**: The source disk data is coded as an uncompressed bit-for-bit replica of the raw sector content.
  - **E01 - EnCase format**: The source disk data is coded as a legacy EnCase evidence file. This is the default setting.
  - **Ex01 – EnCase 7 format**: The source disk data are coded as an EnCase Version 7-compatible evidence file.

- **File Size**: The source segment size for a series of image files in a disk-to-file duplication. The default setting is 2 GB.

- **Error Granularity**: The granularity of failed reads. The default setting is Exhaustive, which attempts to recover data down to a single sector; otherwise, the TD3 only retries at a 64-sector resolution.

- **Error Retry**: The number of times to retry a failed read. The default setting is Retry once.

- **Verification**: Enables verification of the generated image. The default setting is Off.

**Duplicator Info**

Duplicator Info provides the following system information:

- **TD3 F/W Version**: Shows the current firmware version of the TD3. Firmware is installed on the SD card located at the back of the unit.
- **TD3 Build ID**: Shows the build identifier for this firmware.
- **TD3 Serial Number**: Shows the TD3 unit’s serial number.
- **TD3 Ethernet IP Address**: Shows the IP address of the TD3’s internal Ethernet port.
- **TD3 Ethernet MAC Address**: Shows the Media Access Control address on the TD3’s internal network interface card Ethernet port.
- **TDPXE Ethernet 1 IP Address**: Shows the IP address of an attached TDPXE’s ‘Ethernet 1’ port.
- **TDPXE Ethernet 1 MAC Address**: Shows the Media Access Control address on the attached TDPXE’s Ethernet 1 network interface card.
- **TDPXE Ethernet 2 IP Address**: Shows the IP address of an attached TDPXE’s Ethernet 2 port.
- **TDPXE Ethernet 2 MAC Address**: Shows the Media Access Control address on the attached TDPXE’s Ethernet 2 network interface card.
- **iSCSI Initiator**: Shows the iSCSI qualified name (ION) for iSCSI targets exposed by the TD3.
- **NAND Hash**: Shows the MD5 hash of the internal NAND flash that can be verified at Tableau.com.
- **Uboot Version**: Shows the version of the firmware resident within the TD3.
- **View Licenses**: Shows the license agreements for various open source software packages used within the TD3.

![Duplicator Info](image)

**Profile Management**

Profile Management provides options for managing duplication profile information and privileges. You can configure each profile with default settings. The TD3 administrator can set a default profile. Profile Management includes the following options:

- **Change Current Profile**: Tap to activate a duplication profile from the list of available profiles. The factory default profile is Profile1. The default password for Profile1 is `password`.

![Change Current Profile](image)

- **Lock/Unlock Current Profile**: Tap to lock or unlock the active profile using its password. You must unlock a profile before making changes to it.
- **Change Profile Password**: Tap to change the active profile's password. To change the password, enter the old password and the new password. Reenter the new password for confirmation.

- **Change Profile Lock Timeout**: Tap to set the profile lock timeout period to 15 minutes, 30 minutes, 1 hour, or when changing the profile. This time period determines how long a profile remains unlocked before the TD3 automatically locks it. An unlocked profile can be changed by any user with physical access to the TD3.

- **Admin Settings**: Tap to make administrative changes to the TD3. **Admin Settings** includes the following:
  - **Change Default Profile**: Tap to select the default duplication profile from the list of available profiles.
Setting up the TD3

- **Delete Profile**: Tap to delete a profile from the profile list.

  ![Delete Profile Screen](image)

- **Add Profile**: Tap to add a profile to the profile list.

  ![Add Profile Screen](image)

- **Change Profile Password**: Tap to change the password of the active profile. Tap the active profile name for the list of inactive profiles. After selecting a profile, enter the administrator password and new profile password. Reenter the new password for confirmation.

  ![Change Password Screen](image)
Change Admin Password: Tap to change the administrator password. Enter the old password and new password. Reenter the new password for confirmation.

**Updating TD3 Firmware**

The TD3 loads its firmware from an SD card located on the back of the unit. When a TD3 firmware update becomes available on the Tableau Web site, you can use the Tableau Firmware Update utility for Windows (TFU) to update the SD card.

To remove the SD card, turn the TD3 power off, then firmly push the SD card inward and release. The SD card pops out. Gently remove the card and store it safely.

**Connecting Hard Disks**

The following procedure provides the necessary steps for safely connecting hard disks to the TD3. This procedure applies to typical 3.5” SATA and IDE hard disks.

To connect hard disks to the TD3:

1. Connect the Tableau SATA Storage Module Disk Enclosure (TDS1 or TDS2) to the bottom of the TD3 by sliding the TD3 on top of the disk enclosure from left to right until it is securely connected. If you want two copies of the data, use two TDS2 SATA Disk Enclosures to allow for twinning mode. See Twinning Mode on page 27 for more information.
2. On the back of the TD3, connect the TP4 power supply to the TD3 power input.
3. Using the appropriate line cord, plug your TD3 into an AC power source. The green DC Power In LED indicates that power is available at the power connector.
4. Confirm that the TD3 power switch is off (the Power LED will be off).
5. For a SATA source disk connect the drive directly to the TD3 using the appropriate cable.
   
   TC4-8-R2: SATA drive unified cable (connected to the SATA power port on the front edge).
6. For an IDE hard disk, attach the TDPX5 expansion module to the left side of the TD3. Connect the source disk with its signal cable to the TDPX5 signal input using the appropriate cable.
Setting up the TD3

25

TC6-8 IDE signal cable (connected to the TDPX5 IDE Expansion Module on the left side).

TC2-8-R2 hard disk power cable (connected to the power connector on the side of the TDPX5 IDE Expansion Module on the left side).

7. Turn on the TD3 by pressing the TD3 power switch located on the front of the unit to the lower left. The green Power LED indicates that the duplicator is turned on.

Note: When connecting an IDE source disk to the TD3, always connect the blue end of the IDE cable (TC6-2 or TC6-8) to the TD3, and the black end to the hard disk. If using a cable not supplied by Tableau, ensure that the colored stripe on the cable aligns with Pin #1 on the hard disk. Failure to do so can result in unreliable communication between the hard disk and the TD3.

Connecting Notebook Hard Disks

To connect a 1.8" or 2.5" notebook hard disk, use the TC6-2 IDE signal cable in conjunction with one of the following notebook adapters:

- **TDA5-18** 1.8" notebook adapter
- **TDA5-25** 2.5" notebook adapter
- **TDA5-ZIF** 1.8" ZIF adapter and cables
- **TC20-3-2 ZIF** cable for 0.2mm ZIF connectors
- **TC20-3-3 ZIF** cable for 0.3mm ZIF connectors

Note: Use only the shorter TC6-2 (2") IDE cable when connecting a notebook drive adapter to the TD3. Do not use the longer TC6-8 (8") IDE cable with notebook drive adapters. ZIF drives and some notebook drives require a very short data path between the drive and the controller, so using anything except the 2" cable can result in unreliable communication between the disk drive and the TD3.

Drive Detection

After initialization, the TD3 begins drive detection. Icons display on the left and right sides of the Main Menu, indicating the types of source and destination drives that have been recognized. Source drives are shown on the left side of the screen and destination drives on the right. Depending on the type of operation to be performed, you must select a source or destination drive before an operation can be performed. Operations that require a source drive require that a single source is selected if more than one source drive is present. Similarly, operations that require a destination require that a single destination be selected, if more than one destination is available. If there is only one source or destination, it is automatically selected and used.
Tapping a drive icon on the left (source) or right (destination) of the Main Menu displays additional information about the drives connected:

![Destination Disk Info](image1)

![Source Disk Info](image2)

On the bottom of the Source Disk Info screen is a **View SMART Report** button:
Tapping the **View SMART Report** Button brings up the Source Disk’s SMART Info for examination:

![SMART Info](image)

Tapping the **Save** button copies this information to the log.

**Twinning Mode**

When two Tableau TDS2 SATA Disk Enclosures are connected to the TD3 they are automatically put in twinning mode. This allows for a source to be copied to two destinations with little to no performance penalty. Occasionally one disk might be recognized before the other disk. If this happens, wait for the second disk to be recognized.

Disk Icon (on the right) with only one TDS2 connected:
Disk Icon (on the right) with two TDS2s connected:

Disk Information screen when in twinning mode (Tap the SATA-Out icon to view this):

Scroll down to see information about the individual drives connected:
The following table highlights the differences that will be encountered when in twinning mode:

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Twinning Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplicate</td>
<td>The source drive will be copied to both SATA drives in the TDS2 enclosures. Both destination drives can then be used on separate machines and the resulting images (not necessarily disks) will have identical hashes. In cases where drives do not have matching storage capacities, the smaller drive will limit the amount of data that can be copied. A format must be done before a disk can be duplicated to the destination disk set.</td>
</tr>
<tr>
<td>Format</td>
<td>Both drives will be formatted at the same time and the maximum size will be dependent on the smaller drive. For example, if you run format on a 1000GB and 500GB drive, each drive will have one 500GB partition. The 1000GB drive would then be left with 500GB of unused space. Additionally, the format operation puts a special file on each disk to associate them as a disk set for duplication.</td>
</tr>
<tr>
<td>Wipe</td>
<td>The TD3 can wipe both drives. It wipes them one at a time.</td>
</tr>
</tbody>
</table>
Using the TD3

- Overview
- Duplicate
- Hashing
- Preconditions Checking
- Verifying
- Disabling HPA and DCO
- Blank Checking
- Formatting Destination Drives
- Accessing ext2, ext3, and ext4 Destination Partitions in Windows
- Wiping Destination Media
- Secure Erasing
- Logs Module
Overview

This chapter covers detailed procedures and information for using the TD3. It is organized according to the TD3 module options structure to facilitate navigation.

Navigating TD3 Modules and Options

You can navigate the various modules and options of the TD3 by sliding the module list back and forth and tapping the module icons. The following outline maps the TD3 module options structure.

Main Menu Screen

- **Duplicate**
  - Settings
    - Examiner
    - Case ID
    - Case Notes
    - Duplication Type
    - Destination Dir (disk-to-file only)
    - Image Dir Naming (disk-to-file only)
    - Image File Naming (disk-to-file only)
    - File format (disk-to-file only)
    - File Size (disk-to-file only)
    - Error Granularity
    - Error Retry
    - Verification

- **Hash**
  - Settings
    - Examiner
    - Case ID
    - Case Notes
    - Error Granularity
    - Error Retry
- Verify
  - Settings
    - Examiner
    - Case ID
    - Case Notes
    - Path

- HPA/DCO Disable
- Blank Check
- Format
  - Settings
    - Partition Table
    - Filesystem

- Wipe
  - Settings
    - Examiner
    - Case ID
    - Case Notes
    - Disk
    - Wipe Mode
    - Verification Mode

- Logs
  - Delete Old
  - Save All

- Settings
  - System Settings
    - Start Screen
    - Network
  - Sounds
    - 24-Hour Time
    - Date & Time
    - Brightness
    - Factory Reset
Duplicate Settings
- Examiner
- Case ID
- Case Notes
- Duplication Type
- Destination Dir (disk-to-file only)
- Image Dir Naming (disk-to-file only)
- Image File Naming (disk-to-file only)
- File Format (disk-to-file only)
- File Size (disk-to-file only)
- Error Granularity
- Error Retry
- Verification

Duplicator Info
Profile Management
- Change Current Profile
- Unlock Current Profile
- Change Profile Password
- Change Profile Lock Timeout
  - On change of profile
- Admin Settings
  - Change Current Profile
  - Change Default Profile
  - Delete Profile
  - Add Profile
  - Change Profile Password
- Change Admin Password

Duplicate
The TD3 duplicates hard disks by either cloning or imaging them.

Disk-to-File/Imaging
Imaging, also known as disk-to-file duplication, is the process of copying a source disk to a series of files on a destination disk. The TD3 supports e01, ex01, and RAW/DD for disk-to-file imaging, with compression enabled on e01 and ex01.

If the destination disk is smaller than the source, a RAW/DD image will not fit on the destination drive. However, if using e01 or ex01, the source disk may fit on a smaller disk because these formats compress the data before writing to the destination disk. There is no guarantee that the data will be compressed enough to fit on a smaller destination drive. Use observe extreme caution when attempting to copy a source disk to a smaller destination disk.
**Disk-To-Disk/Cloning**

During disk-to-disk duplication, the contents of the subject disk are copied to the destination, sector-for-sector. If a destination disk is not blank, the TD3 prompts for confirmation to overwrite the contents of the destination disk. This reduces the risk of overwriting valuable data. The following steps describe how to perform a disk-to-disk duplication.

1. Follow the steps listed in **Connecting Hard Disks** on page 24 and turn on the TD3. If you want two copies of the disk, you must connect two TDS2 SATA Disk Enclosures to the TD3.

2. From the Main Menu screen, tap **Duplicate**. The Duplicate screen displays.

3. Tap the **Settings** button. The Duplication Settings screen displays.

4. Specify the following:
   a. Examiner
   b. Case ID
   c. Case Notes
   d. Duplication Type = Disk-to-Disk
   e. Destination Dir
   f. Image Dir Naming
   g. Image File Naming
   h. File Format
   i. File Size
   j. Error Granularity
   k. Error Retry
   l. Verification

5. Tap the **Back** button. The Duplicate screen displays.
6. Tap the **Duplicate** button. The Duplication Status screen displays and imaging begins. To abort the process, press the **Cancel** button.

7. When disk duplication is complete, tap the **View Log** button to **Print** or **Erase** the log.
**Disk-To-File Duplication/Imaging**

During disk-to-file duplication, the contents of the source disk are copied to the destination disk. This process creates a set of files (e01, ex01, or RAW/DD) on the destination disk that you can examine on a host computer.

If you format a destination disk with a supported file system, the TD3 uses that file system. Otherwise you must format the destination disk before beginning the duplication process. To perform disk-to-file duplication:

1. Follow the steps listed in *Connecting Hard Disks* on page 24 and turn on the TD3. If you want two copies of the image and two TDS2 SATA Disk Enclosures are connected to the TD3, the TDS2 disk set must be formatted together on the TD3.

2. From the Main Menu screen, tap **Duplicate**. The Duplicate screen displays.

3. Tap the **Settings** button. The Duplication Settings screen displays.

4. Specify the following:
   a. Examiner
   b. Case ID
   c. Case Notes
   d. Duplication Type = Disk-to-File
   e. Destination
   f. Destination Dir(ectory)
   g. Image Dir Naming
   h. Image File Naming
   i. File Format
   j. File Size
   k. Error Granularity
5. Tap the **Back** button. The Duplicate screen displays.

6. Tap the **Duplicate** button. The Duplication Status screen displays and imaging begins. To abort the process, press the **Cancel** button.

7. When disk duplication is complete, tap the **View Log** button to **Print** or **Erase** the log.
**Files Created During Disk-to-File Duplication**

When performing disk-to-file duplication or imaging, the TD3 creates files on the destination hard disk that contain the data copied from the source hard disk. Each of these files is called a segment.

Segments are written to the destination disk according to the following convention:

\[(\text{root dir})/ \]
\[\text{[directory name]}/\]
\[\text{[filename].E01}\]
\[\text{[filename].E02}\]
\[...\]
\[\text{[filename].E99}\]
\[\text{yyyy-mm-dd hh-mm-ss_nnnnn_TTTTT.LOG}\]

\[\text{[directory name]}\] is the name generated by the TD3 for each separate acquisition.

The \[\text{[directory name]}\] can be auto-generated by the TD3 or you can enter it yourself. Auto-generated names can be based on the date/time, the serial number of the source device, or the model and serial number of the source device. The \[\text{[filename]}\] can also be auto-generated, or you can choose to set it to a constant value.

\[\text{[filename].001}\] is the first segment or portion of the data copied from the source disk. The segment size is a user-settable option and may also be specified in the Settings > Duplication Settings > File Size screen.

When creating a DD image, you can also specify .DMG naming for segments. A DMG file extension can be specified by selecting Main Menu > Settings > Duplication Settings > File Extension Settings. .DMG refers to a file naming convention used by Apple operating systems. If the .DMG naming option is selected, the first segment is named \[\text{[filename].DMG}\] instead of \[\text{[filename].001}\]. All other segments have standard segment names (for example, \[\text{[filename].002}\], \[\text{[filename].003}\], and so on).
A .LOG file is generated by the TD3 for each disk-to-file acquisition. \texttt{yyyy-mm-dd hh-mm-ss} is the duplication task start date/time. The next five characters – \texttt{nnnnn} – are generated from the internal log ID number assigned to the log by the TD3. The \texttt{TTTTT} in the filename refers to the type of task as listed in the following table.

<table>
<thead>
<tr>
<th>Label</th>
<th>Type of Log Entry/Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clone</td>
<td>Disk-to-Disk Duplication</td>
</tr>
<tr>
<td>Image</td>
<td>Disk-to-File Duplication</td>
</tr>
<tr>
<td>Verify</td>
<td>Verify Disk Image</td>
</tr>
<tr>
<td>Format</td>
<td>Disk Formatting (destination only)</td>
</tr>
<tr>
<td>Hash</td>
<td>Disk Hashing (source only)</td>
</tr>
<tr>
<td>Wipe</td>
<td>Disk Wiping (destination only)</td>
</tr>
<tr>
<td>Smart</td>
<td>SMART Report for Disk</td>
</tr>
</tbody>
</table>

**Disk-To-Disk/Cloning**

During disk-to-disk duplication, the contents of the subject disk are copied to the destination, sector-for-sector. If a destination disk is not blank, the TD3 prompts for confirmation to overwrite the contents of the destination disk. This reduces the risk of overwriting valuable data. The following steps describe how to perform a disk-to-disk duplication.

1. Follow the steps listed in \textbf{Connecting Hard Disks} on page 24 and turn on the TD3. If you want two copies of the disk, you must connect two TDS2 SATA Disk Enclosures to the TD3.
2. From the Main Menu screen, tap \textbf{Duplicate}. The Duplicate screen displays.
3. Tap the **Settings** button. The Duplication Settings screen displays.

![](image1)

4. Specify the following:
   a. Examiner
   b. Case ID
   c. Case Notes
   d. Duplication Type = Disk-to-Disk
   e. Destination Dir
   f. Image Dir Naming
   g. Image File Naming
   h. File Format
   i. File Size
   j. Error Granularity
   k. Error Retry
   l. Verification

5. Tap the **Back** button. The Duplicate screen displays.

6. Tap the **Duplicate** button. The Duplication Status screen displays and imaging begins. To abort the process, press the **Cancel** button.
7. When disk duplication is complete, tap the **View Log** button to **Print** or **Erase** the log.

![Duplication Status](image)

**Duplication Over a Network**

Sometimes it is safer or easier to have source or destination disks in separate physical locations. For this situation, the TD3 supports using an iSCSI target as a source or destination disk and a CIFS share as a destination disk. The TD3 must be connected to a network before using either iSCSI or CIFS settings.

**Using an iSCSI Target**

1. Select **Settings > iSCSI**. First turn iSCSI on, then click **Discover New Targets**.

![iSCSI Settings](image)

2. Next, enter the IP address of the iSCSI target and the username and password (optional).
3. After entering the iSCSI target information, press **Discover**. Some Windows servers may require that you give the TD3 access to the iSCSI share. After being successfully connected, a list of available iSCSI shares displays:

![Discovered ISCSI targets](image)

4. Click the iSCSI target:

![ISCSI Login](image)

5. Determine if this iSCSI target should be used as a source or destination drive and select the appropriate option. An iSCSI target can also be bookmarked and set up to be connected automatically on startup after the active profile has been authenticated.

6. Scroll down to the bottom of the screen and enable the iSCSI target. An iSCSI icon displays on either the left (source) or right (destination) side of the Main Menu screen:

![Main Menu](image)
7. In cases where multiple sources or destinations are available, tap the appropriate source/destination icon and click Select as Source drive or Select as Destination drive.

8. The selected drive is designated by a green arrow on the Main Menu screen, as shown below.

You can now use the iSCSI target like a regular disk.

For more information regarding iSCSI targets, see the iSCSI section on page 12.

If an iSCSI target is set up under a profile, the TD3 prompts you for the profile password to automatically mount the iSCSI target on startup.
Using a CIFS Share

1. Select Settings > CIFS (Windows File Share) and enter the IP Address, Share name, username, and password for the CIFS share.

2. Slide the button on the top to turn on the CIFS (Windows File Share).

   Note: the TD3 supports using a CIFS share as a destination only.

3. A CIFS icon displays on the right side of the main menu. If more than one destination is available, select one and enable it. A destination is designated with a green arrow.

You can now use the CIFS share as a destination. Note the following restrictions:

- A CIFS share takes the form of a filesystem; you cannot perform a disk-to-disk duplication to a CIFS share.
- The Wipe, Blank Check, and Format options are not available when a CIFS share is selected as a destination.

However, you can use Duplicate (Disk-to-File) and Verify with a CIFS share as the destination.
Hashing

Forensic practitioners may need to calculate the hash values, or fingerprints, for a source disk without making a copy of the disk. The TD3 Hash module generates MD5 and SHA-1 hash values for a source disk.

To calculate hash values for a source disk, tap the Hash icon from the Main Menu screen, and in the Hash screen, tap the Hash button.

You can cancel the hashing operation at any time by tapping the Cancel button.

If the source disk has an HPA-protected region, the TD3 automatically disables the HPA before performing the hash calculation. The TD3 functions the same way during duplication. If you compare the hash values produced when duplicating a disk and when using the Hash module, the results should be the same.

When the hashing operation is finished, tap the View Log button to view the MD5 and SHA-1 hash results at the bottom of the log.
Preconditions Checking

Before starting a Disk-to-Disk or Disk-to-File duplication, the TD3 automatically checks for a number of preconditions. Some preconditions are warnings, and you can choose to continue or cancel after viewing each one. Some preconditions are fatal and require that the duplication process be aborted. One condition pauses the process and prompts you to intervene.

The following table summarizes the preconditions checked by the TD3 prior to duplication.

<table>
<thead>
<tr>
<th>Name</th>
<th>Disk-to-Disk or Disk-to-File</th>
<th>Type</th>
<th>Explanation</th>
</tr>
</thead>
</table>
| Source Disk HPA             | Both                        | Warning | Reports that HPA is in use on the source disk.  
**Note:** The TD3 automatically removes HPA on the source disk. This warning serves to notify you that an HPA was present on the source disk. |
| Source Disk DCO             | Both                        | Warning | Reports that DCO is in use on the source disk.  
The TD3 does not automatically remove DCO on the source disk. Removing DCO requires a permanent modification of the source disk. This dialog allows removal of the DCO before imaging the drive and then restores it after completion of the operation. The DCO could also be left in place for the operation or the imaging operation could be canceled. The DCO can be manually removed before this operation using the HPA/DCO Removal operation from the Main Menu screen. |
| Destination Disk HPA or DCO | Both                        | Warning | Reports that either HPA or DCO is in use on the destination disk.  
The TD3 does not automatically remove HPA or DCO on the destination disk. This warning serves to notify you that the duplicator will not be using the total size of the destination disk. |
<p>| Destination Disk Too Small  | Disk-to-Disk                | Warning | If the source disk is larger than the destination, you may opt either to duplicate the portion of the source disk that will fit on the destination or to cancel the duplication. |
| Source Disk May Be Blank    | Both                        | Warning | The TD3 checks selected sectors on the source disk by looking for non-blank data patterns. If all of the checked sectors appear to be blank, the TD3 warns that the source may be blank. This does not mean that the source is blank, but it could mean that either the source has been partially wiped or an ATA password has been set for the source drive. |</p>
<table>
<thead>
<tr>
<th>Name</th>
<th>Disk-or</th>
<th>Type</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Destination Disk Is Not Blank</td>
<td>Disk-to-Disk</td>
<td>Warning</td>
<td>The TD3 checks selected sectors on the destination disk looking for non-blank data patterns. If the destination disk is not blank, it could be unintentionally overwritten. This warning provides the opportunity to abort the duplication.</td>
</tr>
<tr>
<td>Destination Disk Does Not Contain A Supported File System</td>
<td>Disk-to-File</td>
<td>Fatal</td>
<td>When performing disk-to-file duplication, the TD3 requires a supported file system. If the destination disk already contains a supported file system, the TD3 proceeds with duplication without overwriting existing files. If the destination disk does not have a supported file system, the TD3 aborts the duplication. You may either manually switch the destination disk or format the destination disk with the Format module on the Main Menu screen.</td>
</tr>
<tr>
<td>Destination Disk Too Small</td>
<td>Disk-to-File</td>
<td>Warning</td>
<td>When performing disk-to-file duplication, the TD3 checks the available space on the destination disk. If the content of the source exceeds the capacity of the destination, the TD3 issues a warning and provides an option for either canceling the duplication or proceeding.</td>
</tr>
<tr>
<td>Image Directory is in Use</td>
<td>Disk-to-File</td>
<td>Fatal</td>
<td>When performing disk-to-file duplication, the TD3 checks whether the destination image directory already exists on the disk. If the intended duplication would overwrite an existing image directory, the duplication is aborted. You may either go to Settings and specify a different directory for duplication or go to Duplication Settings and remove the existing directory in the Destination Directory navigation screen.</td>
</tr>
</tbody>
</table>
Verifying

The Verify module verifies the integrity of an existing image file. The following procedure provides the steps for verifying an image file on a destination disk.

1. In the Main Menu screen, navigate to **Verify > Settings**.

2. Specify the source and path of the image file you want to verify and navigate back to the Image Verify screen.

3. Tap the Verify button. The Verify Status screen displays.
4. When image verification is complete, click the View Log button.

Disabling HPA and DCO

The TD3 automatically detects the use of the ATA HPA (host protected area) and DCO (device configuration overlay) feature sets. Both HPA and DCO feature sets can be used to reduce the apparent capacity of a hard disk. From a forensic point of view it is valuable to know if HPA or DCO are in use. With that knowledge, the forensic practitioner can make an informed decision about whether or not to acquire data in the hidden regions of the drive.

You can disable HPA without making a permanent modification to the drive, so the TD3 automatically disables HPA on any hard disk connected to the source side of the duplicator. It is not, however, possible to disable DCO without making a permanent modification to the hard disk. For this reason, the TD3 does not automatically disable DCO on the source hard disk.

The TD3 never makes automatic changes to HPA and DCO on a destination hard disk. The TD3 is designed to give the forensic practitioner complete control over the destination hard disk. If you choose to restrict the destination drive capacity using HPA or DCO, the TD3 will not override that decision.

The options within the HPA and DCO Removal screen allow you to permanently disable the DCO and HPA on the source hard disk under user control. You can access this module by tapping HPA/DCO Disable in the Main Menu screen.

Removing HPA and DCO

You cannot remove a DCO-protected region on a hard disk without also removing any HPA-protected region. If you want to permanently remove both the HPA and DCO on the source hard disk, use this option.
Blank Checking

The Blank Check module does a quick blank check on the source drive.

To do a blank check, tap the Blank Check icon in the Main Menu screen and select Fast, Smart, or Complete, described in the following table. After selecting a blank check option, tap the Blank Check button on the right to begin the blank check.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast</td>
<td>Quickly checks to determine if the disk appears to be blank by reading in and checking the sectors in the Master Boot Record, the Primary GPT, and the Secondary GPT.</td>
</tr>
<tr>
<td>Smart</td>
<td>Fast and reads in 10% of the available sectors randomly to determine whether they are blank.</td>
</tr>
<tr>
<td>Complete</td>
<td>Reads in 100% of the available sectors to check if the drive is blank.</td>
</tr>
</tbody>
</table>

**Note:** A sector is considered blank if it contains only the same repeated two byte pattern. Any non-repeating pattern is considered to be non-blank. However, each individual sector may contain different repeating patterns. If any sector is found to not be blank, the drive is not considered blank, and the blank check will stop.

The Fast and Smart blank check options do not perform exhaustive checks of the entire drive. It is possible for a drive to appear to be blank according to the Fast or Smart check while still storing forensically relevant information. You should treat blank source disks with some caution and use other tools, such as a Tableau write blocker, to examine the drive to determine whether it contains forensically relevant information.

Formatting Destination Drives

When using disk-to-file imaging, you must format the destination drive with a file system that is recognizable by the TD3. Currently, the TD3 supports destination disks that are formatted as ext2, ext4, or exFAT. Use of ext4 is recommended for best performance, while exFAT is recommended for ease of accessing image files with Microsoft Windows. You can format USB drives connected to the read/write port on the right side of the TD3 with ext2, ext4, exFAT, or FAT32.
From the Format menu you can manually format the destination disk.

1. In the Main Menu screen, navigate to **Format > Settings**.
2. Specify settings for Partition Table and Filesystem.
   
   **Note:** Microsoft Windows can use non-removable drives only if they have a partition table.
3. Navigate back to the Format screen and tap the **Format** button. The formatting task begins.

### Accessing ext2, ext3, and ext4 Destination Partitions in Windows

One method of accessing the evidence files written to the destination drive is by connecting the destination drive to a host computer using a Tableau write blocker. Microsoft Windows does not natively support ext partitions. Therefore, you must use a third-party driver when accessing the files on a destination drive which has an ext2, ext3, or ext4 partition, created using disk-to-file imaging on the TD3.

This section describes how to use a free, open-source application and driver called Ext2FSD to mount the ext2, ext3, or ext4 TD3 evidence drive from Windows.

You can download the application and driver from the Ext2Fsd Project site:

http://sourceforge.net/projects/ext2fsd/files/Ext2fsd/0.51/
Prerequisites, Assumptions, and Limitations

- You have successfully created e01, ex01, or RAW/DD images on the evidence storage drive using the TD3.
- The TD3 does not contain any error messages (reader threads, read errors, or write errors) in the logs or the display.
- You have a Windows XP or higher forensic computer and have successfully installed Ext2FSD v0.51 (or higher).
- You have a secondary hard drive that is Windows compatible and formatted as FAT32, exFAT, or NTFS.
- The secondary storage drive has enough space to store all the evidence files currently on the TD3 ext2, ext3, or ext4 evidence drive.
- If using a FAT32 formatted secondary drive, the file size limit is 2000 MB or 2 GB per file. If the TD3 was configured to write segments (RAW, DD, E01, or Ex01) larger than 2 GB, you must choose a different format.
- This method is recommended only for copying the files to a physical Windows compatible secondary hard drive, not for running EnCase against the mounted ext2, ext3, or ext4 TD3 evidence drive itself. Guidance Software recommends testing these processes first, before using them on live evidence.

Procedure for Mounting ext Volumes

Because Ext2FSD v0.51 can parse ext2, ext3, and ext4 partitions, it can be used to view the files as long as Windows can see the physical disk of the TD3 evidence drive. You can browse to the mounted Ext partition in Windows and copy the evidence files directly to a Windows compatible evidence drive.

1. Connect the TD3 ext2 or ext4 evidence drive to the forensic machine using a write-blocker (optional, but recommended).
2. If Windows asks to format the drive, click No or Cancel.
3. Confirm that Windows can see the physical drive in Drive Management.
4. Open Ext2FSD v0.51 or higher and click **Tools > Service Management**.

5. Click **Start** to start the mounting service. Click **Apply** to close the dialog box.
6. Confirm that the ext has been successfully mounted by confirming the volumes on the main screen.
7. Using Windows Explorer, browse to the volume letter indicated (in this example, H) and browse to the evidence files.

Wiping Destination Media

The TD3 provides three options for wiping destination media:

- One-pass wipe.
- Multi-pass wipe.
- Secure erase (SSD media only).

1. Follow the steps listed in Connecting Hard Disks on page 24 and turn on the TD3. No source disk is necessary.
2. From the Main Menu screen, navigate to **Wipe > Settings**.

3. Specify settings for Wipe Mode and Verification Mode:

4. Navigate back to the Wipe Settings screen and tap the **Wipe** button. The Wipe Disk Status screen displays.
Secure Erasing

Secure Erase completely deletes all data on a solid-state drive (SSD). This operation usually takes less than ten seconds. The Secure Erase option displays in all TD3 settings, but works only on SSDs that support it.

The TD3 does not support Secure Erase on rotating hard disk drives. Many manufacturers of rotating media hard disks claim they support Secure Erase, but not all implement this feature properly. A hard disk may be rendered permanently inoperable when this feature is improperly implemented or if the command is interrupted.

If you attempt to use Secure Erase on a drive that does not support it, the following dialog displays.

If you attempt to use Secure Erase on a rotating media hard drive that claims to support this feature, the following dialog displays.

Logs Module

Whenever the TD3 performs an operation of forensic relevance, it creates a log entry to record that operation. The TD3 has internal flash memory with the capacity to store very large numbers of logged operations. The Logs module lets you view, print, save, and erase log entries.
Viewing Logs

Tapping **Logs** from in the Main Menu screen displays a list of the logs currently recorded in the TD3 internal flash memory. The most recent log entry is displayed at the top of this list with the oldest log entry at the bottom of the list. Log entries display as shown below:

<table>
<thead>
<tr>
<th></th>
<th>Log List</th>
<th>1:05 PM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hash</td>
<td>Wed Dec 18 13:04:54 2013</td>
<td>ok</td>
</tr>
<tr>
<td>Image</td>
<td>Wed Dec 18 13:04:33 2013</td>
<td>ok</td>
</tr>
<tr>
<td>Image</td>
<td>Wed Dec 18 13:04:14 2013</td>
<td>ok</td>
</tr>
<tr>
<td>Hash</td>
<td>Wed Dec 18 13:03:32 2013</td>
<td>ok</td>
</tr>
<tr>
<td>Verify</td>
<td>Wed Dec 18 13:03:22 2013</td>
<td>ok</td>
</tr>
<tr>
<td>Image</td>
<td>Wed Dec 18 13:02:47 2013</td>
<td>ok</td>
</tr>
</tbody>
</table>

The first part of the line specifies the type of entry. The second part specifies the day, date, and time. The last part specifies the result of the logged operation.
Sample Log

The TD3 maintains detailed logs for each task initiated by the user. Here is a sample of an error-free log for a Disk-to-File acquisition.

---Start of TD3 Log Entry-----

Task: Disk Image
Status: Ok
Created: Thu Dec 8 11:27:18 2011
Started: Thu Dec 8 11:27:18 2011
Closed: Thu Dec 8 11:46:31 2011
Elapsed: 19 min
User: <<not entered>>
Case ID: <<not entered>>
Case Notes: <<not entered>>
Imager App: TD3
Imager Ver: Preview Release

---Source Disk---

Interface: SATA
Model: WDC WD740GD-00FLA2
Firmware revision: 31.08F31
Serial number: WD-WMAKE1826691
Capacity in bytes: 74,355,769,344 (74.3 GB)
Block Size: 512 bytes
Block Count: 145,226,112
  Power-ON Block Count: 145,226,112
  HPA Block Count: 145,226,112
  DCO Block Count: 145,226,112

---Disk Imaging Results---

Output file format: dd/raw
Destination filename convention: Default
Chunk size in bytes: 0 (0 bytes)
Chunks written: 1
Filename of first chunk: 2011-12-08_11-27-18/image.001
Total errors: 0
Acquisition MD5: 3a16235739236d13bc67c6edc3f6dd1f
Acquisition SHA-1: b1ba2b21b8874f7ce0e5d7aa5bca0c714c61721

---End of TD3 Log Entry---

If the TD3 detected any bad sectors on the source drive, it would have added a section at the end of the TD3 log. This additional section would list the sector address and sector length of each unreadable region of the source disk.
Using the TD3

Saving Logs

You can save all logs to a USB storage device connected to the right-side USB port. After connecting a USB storage device, tap the **Save All** button. Logs are saved in an ASCII text format. Use a text editor to view the logs.

Writing Logs to a USB Storage Device

The TD3 can write logs to a USB storage device attached to the USB port on the right side of the TD3.

1. To see the log list, from the Main Menu screen, tap **Logs**.
2. To save all logs in the log list, tap the **Save All** button, then the **Browse** button to specify a path.
3. You can tap the **New Folder** button to use the TD3’s stamps for date/time, serial number, or model number. Use a keyboard or the touchscreen to enter a folder name manually.
4. After you specify a path for your logs, tap **OK** to get back to the Save Logs screen.
5. Tap the **Save Logs** button to save all logs in the log list.

Printing Logs

You can print logs to a USB printer attached to one of the TD3 USB ports. After connecting a USB printer to one of the TD3 USB ports, tap a log in the Log List, then tap the **Print** button.

The TD3 is compatible with USB printers which support the USB Printer Class Specification. The USB printer must support raw ASCII printing.

Erasing Logs

You can erase logs by tapping a log in the Log List and tapping the **Erase** button.

You can erase all but the 20 most recent logs by pressing the **Delete Old** button on the Log List.
CHAPTER 4

Expansion Modules

- Overview
- TDXP5 Expansion Module for IDE Drives
- TDXP6 Expansion Module for SAS Drives
- TDXP8-RW USB 3.0 Expansion Module for USB Destination Drives
- TDXP8E Gigabit Ethernet Expansion Module
Overview

This chapter describes the Tableau TD3 expansion modules, which extend imaging and network capabilities in an easy to connect and use manner. The TDPX5 and TDPX6 expansion modules support forensic imaging of IDE and SAS storage devices respectively. Users desiring the convenience of imaging to USB 3.0 devices can use the TDPX8-RW module. The TDPXE Gigabit Ethernet module improves network performance while supporting multiple network connections (to the same or different networks).

Built for high performance, ease of use, and reliability in forensic imaging applications, each module snaps in and attaches to the expansion port on the left side of the TD3. No separate power supply or cables are required.

The standard TD3 kit ships with a TDPX5 (IDE) source and TDPX8-RW USB 3.0 output module. You can purchase the TDPX6 (SAS) and TDPXE (Gigabit Ethernet) modules separately. Contact Guidance Software or your authorized Tableau reseller for more details.

TDPX5 Expansion Module for IDE Drives

The TDPX5 allows acquisition of IDE (Integrated Drive Electronics, also known as Parallel ATA or PATA) drives by the TD3 Imaging system.

Using the TDPX5

1. Connect the TDPX5 to the TD3 by sliding it into the left side of the TD3.

   Note: The TDS2 and TDS1 SATA storage enclosures are "keyed" for proper expansion module alignment.
2. Connect an IDE drive via the TC6-8 ribbon cable (blue connector goes to the TDPX5) and TC2-8-R2 power cable.

3. Power on the TD3.

4. An icon displays on the left side of the TD3 screen indicating that an IDE drive is recognized and is ready for use.
TDPX6 Expansion Module for SAS Drives

The TDPX6 allows acquisition of SAS (Serial Attached SCSI) drives by the TD3 Imaging system.

Using the TDPX6

1. To connect the TDPX6 to the TD3, slide it into the left side of the TD3.
2. Connect an SAS drive via the TC4-8-R2 cable.
3. Turn on the TD3.

4. An icon displays on the left side of the TD3 screen indicating that an SAS drive is recognized and is ready for use.
TDPX8-RW USB 3.0 Expansion Module for USB Destination Drives

The TDPX8-RW allows use of USB 3.0 storage media as a destination drive for the TD3 Imaging system. TDPX8-RW is a read/write expansion module as denoted by its bold yellow labeling.

Using the TDPX8-RW

1. Connect the TDPX8-RW to the TD3, and slide it in to the left side of the TD3.
2. Connect a USB drive via the TC-USB3-18cable to the TDPX8-RW module. If the drive’s power requirements exceed that of the USB 3.0 specification (5V @ 900mA), use an external power source.
3. Turn on the TD3.

4. An icon displays on the right side of the TD3 screen indicating that a USB drive is recognized and is ready for use as a destination drive.

**TDPXE Gigabit Ethernet Expansion Module**

The TDPXE allows the TD3 imaging system to be connected to two additional Ethernet networks. Performance of the TDPXE module is superior to the built-in Gigabit Ethernet port when used with switches and servers that support Jumbo Packets.
Using the TDPXE

1. Connect the TDPXE to the TD3, and slide it into the left side of the TD3.
2. Connect one or more of the RJ45 ports to your network or networked device.
3. Turn on the TD3.
4. Navigate to the network settings screen and set up each of the network ports as needed. Consult with the network administrator before connecting this system to a network, or if you need help with the settings necessary to use this module correctly.
CHAPTER 5

Troubleshooting and Support

- Troubleshooting Common Problems
- Support
Troubleshooting Common Problems

This section covers the following troubleshooting issues and solutions:

- Power supply issues.
- Problems with disk detection.
- Replacing the backup battery for the real-time clock.

**Power Supply Issues**

The TP4 power supply provided with the TD3 is a 24-volt power supply that uses a barrel connector to interface with the TD3. It is capable of powering the TD3 and nearly all combinations of one, two, or three hard disks. The TD3 also employs staggered power sequencing for the source and destination hard disks. With staggered sequencing, power is first provided to one hard disk as it spins up, then to the second hard disk as it spins up, and finally to the third hard disk. It is normal to hear the source and destination drives spin up separately.

During power-on initialization and self-test, the TD3 checks the output voltages of the TP4 power supply. If the voltage is below the minimum specification, the TD3 displays a warning.

There is a green DC power LED on the rear edge of the TD3, next to the female DC power barrel connector. If the TP4 power supply is connected properly to the TD3 and to AC power, the green LED illuminates. If you are having difficulty turning the TD3 on, check the status of the DC power LED to ensure that the TD3 is receiving power from the TP4 power supply.

**Problems with Disk Detection**

When using a product like the TD3, the most common problem you may encounter is a failure to achieve drive detection. Most drive detection problems are the result of improper cabling. The following table lists the most common drive detection problems and corrective actions.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hard disk does not spin up.</td>
<td>Check the power connection between the TD3 and the hard disk. Be especially careful to ensure that the 4-pin power connectors are properly seated in the connectors on the TD3 and on the hard disk (if using cable model TC2-8). The blue connectors should be fully inserted, not loose, in the TD3 and hard disk.</td>
</tr>
<tr>
<td>TD3 does not detect an IDE hard disk.</td>
<td>IDE hard disks should be set for Master or Single Drive.</td>
</tr>
<tr>
<td>TD3 does not detect a 3.5&quot; IDE hard disk.</td>
<td>You can connect typical 3.5&quot; IDE hard disks to the TD3 using either the 8&quot; TC6-8 IDE cable or the 2&quot; TC6-2 cable. In either case, you must connect the blue end of the IDE cable to the TD3. You must not use an IDE cable longer than 8&quot; with the TD3. Always use the Tableau-provided, high quality, 80-conductor TC6-8 or TC6-2 cable.</td>
</tr>
<tr>
<td>Problem</td>
<td>Corrective Action</td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>TD3 does not detect a notebook IDE hard disk.</td>
<td>When using one of the notebook drive adapters provided with the TD3 (model TDA5-18, TDA5-25, or TDA5-ZIF), you must always use the 2” TC6-2 IDE cable. When using a notebook drive adapter, do not use the 8” TC6-8 IDE cable or any non-Tableau IDE cable. When using notebook drive adapters, you must connect the blue end of the TC6-2 IDE cable to the TD3, and you must connect the black end of the cable to the notebook drive adapter.</td>
</tr>
<tr>
<td>TD3 does not detect a ZIF-style notebook IDE hard disk.</td>
<td>There are several models of ZIF hard disks. When using the TDA5-ZIF kit provided with the TD3, refer to the Support pages on <a href="http://www.tableau.com">www.tableau.com</a> for documentation regarding the proper selection and orientation of ZIF cables.</td>
</tr>
<tr>
<td>TD3 does not detect a SATA hard disk.</td>
<td>Use only the 8” TC3-8 SATA cable provided by Tableau. With some SATA hard disks, the SATA connector may be loose. Ensure that the TC3-8 cable is seated properly in the hard disk’s SATA connector.</td>
</tr>
</tbody>
</table>

Tableau has tested the TD3 with an extensive in-house library of different hard disks spanning many years of hard disk development, but there may be compatibility issues with some hard disks. Tableau issues firmware updates to address most compatibility issues. If your hard disk is not recognized by the TD3, check the Support pages on www.tableau.com to see if any firmware updates are available for the TD3.

**Replacing the Backup Battery for the Real-Time Clock**

The TD3 uses a real-time clock (RTC) with a backup battery. The battery has a shelf life of 12-18 months. If you use the TD3 regularly, expect the battery to last longer than 18 months. As the battery discharges, the TD3 displays a low battery warning message.

This section provides an illustrated procedure for replacing the RTC backup battery.

**Compatible Batteries**

The TD3 uses an ANSI/NEDA type 5012LC battery. The following table lists common batteries compatible with this type.

<table>
<thead>
<tr>
<th>Manufacturer</th>
<th>Model #</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maxell</td>
<td>LR1130</td>
</tr>
<tr>
<td>Energizer</td>
<td>189</td>
</tr>
</tbody>
</table>
Opening the TD3

It is necessary to open the TD3 case to replace the battery. You need a #1 Phillips screwdriver to open the TD3 case and a small flat-blade screwdriver to remove the battery.

The following procedure describes the steps for opening the TD3.

1. Disconnect the power supply and all cables from the TD3 before opening the TD3 case. Never connect the power supply or operate the TD3 when the case is open.
2. Remove the SD card from the rear of the TD3.
3. Turn the TD3 upside down on a clean work surface.
4. Remove the four case screws and set them aside. The SATA connector on the bottom of the TD3 is a tight fit. This prevents you from lifting the rear half of the case in a straight direction.
5. Carefully lift the rear half of the plastic case away from the TD3 pulling it toward you, while gently pressing down on the SATA connector. Keep the TD3 secure on your work surface. Lifting or tilting the TD3 might move the main circuit board or loosen a connector and cause a system failure.
6. Carefully set the rear half of the TD3 case aside.

Replacing the Battery

1. Using the flat-blade screwdriver, pry the battery gently from the battery holder.
2. Using a compatible battery, replace the RTC backup battery. For a list of compatible batteries, see Compatible Batteries.
   
   Note: Make sure the positive terminal of the battery is facing upward.

Closing the TD3

To replace the TD3 case:

1. Gently lower the rear case into position, pay particular attention to the SATA connector on the circuit board connected to the main PCB. Tilt the bottom edge of the rear case into position.
2. Ensure that the case and main circuit board are aligned and replace the four case screws. The four screws that hold the TD3 case together also secure the main circuit board.
3. After replacing the four case screws, inspect the TD3 and determine whether the case is tightly secured.

Testing the New Battery

After you have securely fastened the TD3 case, return it to its normal upright position and attach just the TP4 power supply. Turn the TD3 on and observe the startup sequence. You should not see a battery warning dialog, but you will probably see a date/time warning to reset the RTC.

To reset the date/time, from the TD3 Main Menu, select Settings > System Settings > Date and Time.

After resetting the date/time, turn the TD3 off, wait two minutes, then turn the TD3 on. The time, located in the upper right corner of the display, should be correct.
Support

This section provides information on our support for you through:

- Technical Support.
- Online Support Portal.
- Professional Services.
- Training.

Technical Support

Support for your Tableau product is provided by the vendor who sold the device. You can also find additional support by visiting the support pages on the Tableau Web site at:

www.tableau.com/support

The support pages contain answers to common questions, information regarding specific compatibility issues, and firmware updates for the TD3 Forensic Imager.

If you purchased your device from Guidance Software, technical support is available 24 hours a day, excluding weekends and holidays. All technical support inquiries are automatically routed to the open US or UK office 10 PM Sunday – 6 PM Friday, US Pacific time (6 AM Monday – 4 PM Friday, GMT).

Guidance Software offers several support options, including:

- Live Chat.
- Support Request Forms.
- Email.
- Telephone.

Live Chat

From the Guidance Software Support Portal, you can chat live with a Technical Services engineer. From the Support Portal main page, select Live Chat to connect directly to an engineer.

Technical Support Request Forms

Use the Online Request Form to request assistance from a Technical Services engineer. To access the form, click Request Form (https://support.guidancesoftware.com/node/381) in the Support Portal. Note that all fields are mandatory, and filling them out completely reduces the amount of time it takes to resolve an issue.

Email

Although technical support is available by email, you will receive more thorough and faster service when you use the online Technical Support Request Form, available at: (https://support.guidancesoftware.com/node/381).

To request assistance by email, send your message to technicalsupport@guidancesoftware.com. Include as much detail as possible about the issue and the best way to contact you.
Telephone

Telephone technical support is available 24 hours a day, excluding weekends and holidays. All technical support calls are automatically routed to the open US or UK office 10 PM Sunday – 7 PM Friday, US Pacific time (6 AM Monday – 3 AM Saturday, UK time).

US office hours are Monday–Thursday 5 AM–10 PM Pacific time, Friday 5 AM–7 PM Pacific time.
  Telephone: (626) 229-9191, Option 4
  Fax: (626) 229-9199
  1055 East Colorado Boulevard
  Pasadena, CA 91106

UK Office hours are Monday–Friday 6 AM–4 PM UK time.
  Telephone: +44 (0) 175-355-2252, Option 4
  Fax: +44 (0) 175-355-2232
  Thames Central, 5th Floor
  Hatfield Road
  Slough, Berkshire UK SL1 1QE

For your convenience, the following numbers are provided to our English-based support:
   Germany: 0-800-181-4625
   China: 10-800-130-0976
   Australia: 1-800-750-639
   Hong Kong: 800-96-4635
   New Zealand: 0-800-45-0523
   Japan: 00-531-13-0890

Online Support

Guidance Software offers a Support Portal to our registered users providing technical forums, a knowledge base, a bug tracking database, and an Online Request form. The portal gives you access to all support-related issues in one site. This includes:

   User, product, beta testing, and foreign language forums (message boards).
   Knowledge Base.
   Bug Tracker.
   Technical Services Request form.
   Downloads of previous software versions, drivers, etc.
   Other useful links.

Although technical support is available by email, you will receive more thorough and faster service when you use the online Technical Support Request Form (https://support.guidancesoftware.com/node/381). Note that all fields are mandatory, and filling them out completely reduces the amount of time it takes to resolve an issue.

**Registration**

Registration requires you to choose a unique username and password. Provide all requested information, including dongle ID, phone, email address, organization, etc. This helps us identify you as a registered owner of EnCase.

You will receive an email reply within 24 hours. You must follow the link in that email before you can post on the forums. Once you have verified your email address, you are added to the Registration List. Please allow 24 business hours for your account to be approved.

Once your registration is approved, you can access the Support Portal (https://support.guidancesoftware.com/). The Support Portal provides an overview tutorial of the site.

**User, Product, and Foreign Language Forums**

To access the forums, click the Forum Tab (https://support.guidancesoftware.com/forum/) in the Support Portal.

The forums allow registered users to post questions, exchange information, and hold discussions with Guidance Software and other users in the EnCase community. Several discussion groups are available, including:

- **Foreign Language Groups**
  - French
  - Arabic
  - German
  - Spanish
  - Japanese
  - Chinese
  - Korean
Forum Groups

- User Group
- Consultant and Practitioner
- Computer Forensic Hardware Issues
- EnScript Forum

Product Specific Groups

- EnCase Neutrino
- Enterprise
- Field Intelligence Model (FIM)
- eDiscovery

These groups are available only to customers who have purchased the respective products.

Enter a group by clicking the group name.

*Posting to a Group*

To create a new post, click the ![New Thread icon](image). Click the ![Post Reply icon](image) to reply to a post, or use the Quick Reply icon at the bottom of each post.

*Searching*

The forums contain over ten years of accumulated information. Use the **Search** button to search for keywords, or click **Advanced Search** for more specific search options.
Bug Tracker

Use Bug Tracker to submit and check the status and priority of submitted defect and enhancement requests. It is broken down by product, showing the current number of bugs/enhancements and public bugs for each product. To access the Bug Tracker, click **Bug Tracker** ([https://support.guidancesoftware.com/forum/project.php](https://support.guidancesoftware.com/forum/project.php)) in the Support Portal.

Knowledge Base

You can find answers to frequently asked questions (FAQs) and other useful product documentation in the Knowledge Base. You can also submit your own articles to help other EnCase users.

To access the Knowledge Base, click **Knowledge Base** ([https://support.guidancesoftware.com/directory](https://support.guidancesoftware.com/directory)) in the Support Portal.

From here, you can browse, search, and write Knowledge Base articles.

Online Technical Support Request Form

Please use the Request Form for assistance from a Technical Services engineer. To access the form, click **Request Form** ([https://support.guidancesoftware.com/node/381](https://support.guidancesoftware.com/node/381)) in the Support Portal.

Message Boards

The Guidance Software message boards are resources for the computer forensics community to exchange ideas, ask questions, and give answers. The message boards are a valuable resource for the forensic investigator.

Discussions range from basic acquisition techniques to in-depth analysis of encrypted files and more. Thousands of experienced and skilled users are registered on the boards, reviewing posts every day, and providing their expertise on all Guidance Software products.

More information about the message boards, including information on how to join the message board, is located at [http://www.guidancesoftware.com/support/messageboards.asp](http://www.guidancesoftware.com/support/messageboards.asp)
Downloads


If you have difficulties registering your product, contact Customer Service. If you have difficulties downloading the updates, once registered, contact Technical Support.

Other Useful Links

The Support Portal’s landing page contains a section of useful links, including:

- Guidance Software Home Page
- Download Center to download software, hardware, manuals, boot disks, support articles, etc.
- My Account to register your dongle id to receive up to date software by email
- NVD (National Vulnerability Database) Information and Responses
- Guidance Product Version Matrix for checking compatibility of different product versions
- Hardware Recommendations for EnCase Forensic and EnCase Enterprise
- Subscribe to Public Bugs

Professional Services

The Guidance Software Professional Services Division (PSD) combines world-leading computer investigation experts with world-leading forensic technology to deliver turnkey solutions to forensic investigations.

Guidance Software has combined its industry-leading computer investigation technology with a team of the most highly trained and capable investigators in the world to bring you complete turnkey solutions for your business. When you face investigative issues that go beyond your internal capabilities, our professional services group can to respond either remotely or by coming on site to provide the right technology and computer investigation personnel for the job.

Internal Investigations

- Theft of intellectual property.
- Intrusion reconstruction.
- Wrongful termination suit.
Compliance

- Sarbanes-Oxley.
- PII risk assessment.
- California SB 1386.

eDiscovery

- Pending litigation.
- Responsive production.
- Forensic preservation.

Information Security

- Compromise of system integrity.
- Policy review.
- Unauthorized use.
- Forensic lab implementation.

Training

Guidance Software offers a variety of professional courses for the beginner, intermediate, and advanced user of all its applications. In addition to providing a solid grounding in our software, we also provide our students with accepted best practices for investigation, report generation and evidence preservation.

Guidance Software offers courses for law enforcement agencies, organizations concerned with forensics and incident response, and gives training in advanced topics for all users.

Information about all Guidance Software training offerings is available at:
Index

A
  About this Guide • 4
  Accessing ext2, ext3, and ext4 Destination Partitions in Windows • 52

B
  Blank Check • 51
  Blank Checking • 51

C
  Closing the TD3 • 74
  Compatible Batteries • 73
  Configuring the TD3 • 14
  Connecting Hard Disks • 24
  Connecting Notebook Hard Disks • 25

D
  Disabling HPA and DCO • 50
  Disk Capacity and Transfer Rate Measurement Conventions • 4
  Disk-to-Disk/Cloning • 35
  Disk-To-Disk/Cloning • 35, 40
  Disk-To-File Duplication/Imaging • 37
  Disk-to-File/Imaging • 34
  Drive Detection • 25
  Duplicate • 34
  Duplication Over a Network • 42
  Duplication Settings • 18
  Duplicator Info • 20

E
  Email • 75
  Erasing Logs • 61
  Expansion Modules • 63

F
  Files Created During Disk-to-File Duplication • 39
  Format • 51
  Formatting Destination Drives • 51

H
  Hash • 46
  Hashing • 46
  HPA/DCO Disable • 50

I
  Interpreting Audio Feedback • 12
  iSCSI • 16
  iSCSI Discover • 16

L
  Live Chat • 75
  Logs • 58
  Logs Module • 58

N
  Navigating TD3 Modules and Options • 32
  Navigating the TD3 • 10
  Network Settings • 15

O
  Online Support • 76
  Opening the TD3 • 74
  Overview • 5, 32, 64

P
  Power Supply Issues • 72
  Preconditions Checking • 47
  Preface • 3
  Prerequisites, Assumptions, and Limitations • 53
  Printing Logs • 61
  Problems with Disk Detection • 72
  Procedure for Mounting ext Volumes • 53
  Professional Services • 80
  Profile Management • 21

R
  Reading the LEDs • 11
  Remove DCO & HPA • 50
  Removing HPA and DCO • 50
  Replacing the Backup Battery for the Real-Time Clock • 73
  Replacing the Battery • 74

S
  Sample Log • 60
  Saving Logs • 61
  Secure Erase • 58
  Secure Erasing • 58
  Setting up the TD3 • 13
  Settings • 14
Source • 18
Startup Sequence • 14
Support • 75
System Settings • 14

T
Tableau TD3 • 6
TD3 Kit Contents • 7
TDPX5 Expansion Module for IDE Drives • 64
TDPX6 Expansion Module for SAS Drives • 66
TDPX8-RW USB 3.0 Expansion Module for USB Destination Drives • 68
TDPXE Gigabit Ethernet Expansion Module • 69
Technical Support • 75
Technical Support Request Forms • 75
Telephone • 76
Testing the New Battery • 74
Training • 81
Troubleshooting and Support • 71
Troubleshooting Common Problems • 72
Twinning Mode • 27

U
Updating TD3 Firmware • 24
USB Keyboard Support • 12
Using a CIFS Share • 45
Using an iSCSI Target • 42
Using the TD3 • 31
Using the TDPX5 • 64
Using the TDPX6 • 66
Using the TDPX8-RW • 68
Using the TDPXE • 70

V
Verify • 49
Verifying • 49
Viewing Logs • 59

W
wipe • 56
Wiping Destination Media • 56
Writing Logs to a USB Storage Device • 61